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Sono は究極のギター用オーディオインターフェースで
す。アナログ入力段には高電圧でドライブする 12AX7
真空管プリと、アナログ 3 バンドのトーンコントロー
ルを備えました。パワーアンプとキャビネットシミュ
レーションは、「Two Notes」のデジタルプロセッシン
グがオンボード DSP で行えます。

2 つのマイク入力用には Audient の大型コンソールの
マイクプリアンプを採用。拡張用入力は ADAT 又は S/
PDIF で使用できるオプティカル入力をリアパネルに備
えています。

Sono はレコーディング、プラクティス、ライブのセン
ターピースとしてあなたをサポートくれるでしょう。

主な特徴：
o 11 in/4 out USB インターフェース
o 12AX7 真空管プリアンプ
o 3 Band アナログ トーン コントロール
o Two notes パワーアンプ＆キャビネットエミュ

レーション
o Re-amp 出力
o 2x Audient コンソールスタイル マイクプリアン

プ
o ハイパフォーマンス AKM AD/DA コンバーター
o 拡張用 ADAT 入力 
o メインスピーカー出力
o 独立ヘッドフォン出力
o 『ゼロ』レイテンシーモニタリング機能
o USB 2.0
o 24bit/96khz
o メタルシャーシ
o ARC フリーソフトウェア
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安全の手引き同梱品とセットアップ

Sono のボックス内には下記の製品やケーブルが同梱されています。：
• Sono 本体
• 12V DC 電源アダプター
• USB タイプ C ケーブル
• USB タイプ C → タイプ A Cable
• 

マニュアルとARC 

http://www.allaccess.co.jp の Sono ページをご覧ください。マニュアルやソフトウェアのダ
ウンロードがサイトから行えます。
Sono ユーザーには、ARC の登録でレコーディングに非常に役立つプラグインを無償でダウン
ロードできる特典が付いています。是非お試しください。

電源は同梱の 12V DC 専用アダプターを使用してください。

安全の手引き

Sono を付属専用アダプターで AC 電源に接続する前に、以下の説明をお読みください。

付属の 12VDC 専用アダプターの使用する際、感電事故や火災が起きないようにご注意ください。Sono 本体は高電圧で
動作はしていませんが、一般的なアダプター使用と同様にご注意ください。

Sono の付属電源以外は使用しないでください。また、アダプターの故障が起きたと思われる場合でも、電源本体を絶対
に開けないでください。サポートが必要な場合は、support@allaccess.co,jp にご連絡ください。

付属電源はスイッチモードタイプです。出力は 2A、100v 〜 240v @ 50/60Hz の AC 入力電源に対応しますので、海
外でも Sono をお使い頂けます。

http://www.allaccess.co.jp
mailto:support@allaccess.co,jp
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デバイスのセットアップ
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Mac	OSX	インストール	 Mac	OSX	インストール	

接続の確認方法
下記のフォルダーにて、コンピューターが Sono を正
常に認識しているかを確認できます。

Macintosh HD > Applications > System 
Preferences

Sono が I/O デバイスとして設定されているかを確認
します。
また、レコーディング中にエラー音が鳴らないように、
システム・サウンドをオフにすることをお勧めします。

メニュー／タスクバーのアイコン
Mac OS では Sono アイコンが画面右上のメニューバ
ーに表示されます。
こちらをクリックして「Sono ミキサー」にアクセスし
ます。

Show	Mixer	
ミキサーのウィンドウが隠れている場合は、これをク
リックしてミキサーを再表示します。

Quit
「Sono ミキサー」を終了します。

About	Sono
「Sono ミキサー」のバージョン情報を表示します。

Visit	Sono	Knoweldge	Base
Web ブラウザを開き、FAQ が掲載された Audient 
Helpdesk（英語サイト）にアクセスできます。

Check	for	Updates
Audient のサーバーでファームウェアアップデートが
確認します。

動作環境

● OS：Mac OS10.7.5（Lion）以降
● スペック：Intel CPU
● 1GB RAM 以上

以下の手順に従って、ソフトウェアのインストールを
行ってください。

ドライバーソフトウェアをインストールする。
web から最新ソフトウェアをダウンロードして下さい。

audient.com/products/downloads/sono

ダウンロードしたインストーラー（.pkg）を開き、画
面に従ってアプリケーションのフォルダーに「Sono ミ
キサー」をインストールしてください。

Sonoとコンピューターを接続する。
同梱の USB ケーブルで Sono をコンピューターに接続
して下さい。
その後、付属のアダプター電源に接続し、Sono に電源
を供給します。

ステータスLED
接続が完了すると “STATUS” LED が点灯します。

LED が消灯した場合は、何らかの問題が考えられます。
まずコンピューターとの接続を確認してください。

電源アダプターを接続
（100 〜 240V）

USB ポートに接続
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Windows Installation Windows	インストール

接続の確認方法
下記のフォルダーにて、コンピューターが Sono を正
常に認識しているかを確認できます。

スタートメニュー > コントロールパネル > ハードウェ
アとサウンド > サウンド

Sono が既定の I/O デバイスとして設定されているか
を確認します。

「再生」と「録音」どちらも Sono を「規定のデバイス」
として設定してください。

「Sono ミキサー」アプリケーションの起動
インストールが完了すると、システムトレイに「Sono」
アイコンが表示されます。

「Sono ミキサー」は、Sono が接続されている時だけ
使用できます。

More details regarding the system tray menu 
can be found on page 33.

動作環境
● Windows 7 以降（32bit & 64bit）
● スペック：Intel Core 2 - 1.6 GHz 以上、

またはAMD同等
● 1GB RAM 以上 

Sono とコンピューターを接続する。
同梱の USB ケーブルで Sono とコンピューターを接続
して下さい。
その後、付属のアダプター電源に接続し Sono へ電源
を供給します。

ドライバーソフトウェアをインストールする
web から Sono Mixer/「Sono ミキサー」の最新ソフ
トウェアをダウンロードして下さい。

audient.com/products/downloads/sono

ダウンロードしたインストーラー（.exe）を開き、画
面に従ってアプリケーションのフォルダーに「Sono ミ
キサー」をインストールしてください。
インストールが完了したら、コンピューターと Sono
の両方を再起動をお勧めします。

ステータスLED
接続が完了すると “STATUS” LED が点灯します。

LED が消灯した場合、何らかの問題が考えられますの
で、まずコンピューターとの接続を確認してください。

電源アダプターを接続
（100 〜 240V）

USB ポートに接続
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ハードウェア

ハードウェア

ギター	プリアンプ	チャンネル
本機はクラシックなチューブアンプの入力段のように
12AX7 真空管のギターチャンネルを備えています。
このセクションでは、ギタープリアンプチャンネルと
パーフェクトなトーンをセッティングできるように、
使用方法を説明していきます。

本機ギター入力からの信号の流れを表示しました。

Guitar

Valve Stage 1

Input Volume 
Control

Three Band Tone 
Control

Valve Stage 2

Output Volume 
Control

Analogue to Digital 
Conversion

Two Notes Torpedo 
Processing
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ハードウェアハードウェア

3バンドトーン	コントロール

この 3 バンド Bass、Mid、Treble のトーンコントロ
ールは、15 dB のブースト / カットができるアクティ
ブコントロールです。

これらをどうセッティングするのかは、使用ギターや
プレイトーンによって大きく異なります。 
 
例えば、シングルコイルPUのギターでは、高域を少し
ロールオフしてとげとげしさを減らすか、高域をあげ
てミックス中で際立つようにするか…等の使用法があ
ります。

メタルトーンには、Bass ＆ Mid を上げてより重いサ
ウンドします。しかし、それらを上げすぎると抜けの
悪い音になってしまいます。

出力ゲイン	コントロール

出力ゲインコントロールは、2 段目の真空管ステージ
後の信号レベル（A/D コンバーター入力）を調整します。

これは、レベルを上げてドライブした信号が A/D コン
バーターで歪ませないように、信号レベルを調整しま
す。

OUTPUT コントロールの隣にあるメーターは、A/D
コンバーターへ送られる信号レベルを表示しています。
この表示がピーク信号で ‘Good’ が点灯する程度に出
力ボリューム（OUTPUT）を調整してください。

Two	Notes	Torpedoプロセッシング

最後に、本体内の Two Notes パワーアンプと Cab シ
ミュレーション（DSP プロセッシング）を通過します。

本体上にある Drive コントロールは、パワーアンプで
発生するサチュレーションをコントロールします。チ
ューブアンプのボリュームを上げた状態と同じような、
太く力強いドライブサンドが低い信号レベルでも得ら
れます。

同様に、ブルースやジャズの軽いクランチサウンドも
Drive コントロールで調整できます。

さらに、Toerpedo（トーピド）プロセッシングは、キ
ャビネット、マイクロフォン、トーンコントロールな
ども調整が可能です。

ギター
本機の入力は、シングルコイル、ハンバッカー、アク
ティブPUの付いたあらゆるエレクトリックギターとの
使用、さらにベースギターの入力も可能です。チュー
ブアンプの入力と同様のハイインピーダンス入力がこ
れを可能にし、アンプに繋いだ時と同じレスポンスを
感じることができます。 
 
アンプと同様に、ギターのボリュームとトーンの調整
でさらに良い結果が得られます。ソロを弾くときにボ
リューム上げると、真空管の回路段でのサチュレーシ
ョンがダイナミックに起こり、プレイが楽しめます。

真空菅ステージ1	&	2

本機で使用している 12AX7 真空管には、2 つの増幅段
が含まれています。

1 段目はギター入力の直後にあり信号を増幅します。2
段目は 3 バンドトーン回路の後（出力の前）にあります。

これらの両真空管ステージは、信号レベルが上がると
倍音が増えるサチュレーションを起こし、歪みを発生
します。

本機への入力信号を上げれば、入力ステージはサチュ
レーションを起こします。前にも説明しましたように
ギター信号のボリュームを上げるか、ブーストやオー
バードライプペダルを使用して信号レベルを上げます。

2 番目のステージも同じような手法で、入力ゲインと
トーンコントロールを用いて歪ませることができます。
下記のセクションでさらに詳しく説明します。

このプリアンプは歪み専用ではありません。各レベル
を低く保つと、完全なクリーンサウンドが得られます。

入力ゲインコントロール

入力ゲインは、真空管の初段後 0 〜 30dB のゲインを
コントロールします。このレベル設定がトーン回路と
真空管の次段への信号レベルになり、トーンを形成す
る上で影響を与えます。

先の説明にもあるように、このコントロールを上げる
と歪み、低く保つとスパークリングなクリーンサウン
ドが得られます。
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ハードウェアハードウェア

マイクプリ

本機には Audient コンソールのマイクプリを 2 機装備
しています。

これらのマイクプリは、定評ある Audient コンソール
のプリアンプです。楽器ボーカルを問わず、素晴らし
いサウンドでの録音を約束してくれます。

ゲインコントロールのレンジは、0 〜 60dB と非常に
広くあらゆるマイクロフォンに対応します。

また、+48V のファンタム電源の供給も可能です。
+48v のスイッチでオン / オフできます。

ファンタム電源はチャンネル毎にオン / オフできます。
片側にコンデンサー、他のチャンネルに（ファンタム
電源でダメージを受ける）リボンマイクというような
使用方法が可能です。

本機は一度に 2 チャンネルの入力しかプロセスできま
せん。Mic 1 はギター入力使用時にはシグナルパスか
ら外れます。

しかし、Mic/Line 1 からの信号は、ギターチャンネル
へ送れます。真空管プリから３バンドトーンコントロ
ール、トルピードプロセッシングとマイク / ライン信
号を加工できます。

この手法を使えば、ボーカルのエッジを立てたり、シ
ンセに歪みを加えることができます。
信号ルーティングは『To Valve』ボタンを押せば完了
します。

外部プリアンプを接続する

外部プリアンプを接続する場合は、LINE入力1に接続して
ください。

C.A.B ボタンを3秒長押しすることで、Torpedo CABを
適用することができます。

Sono 本体には Tow Notes のお好みセッティングが 3
つ保存できます。

それらは、C.A.B ボタンで順に A、B、C が選べ、A、B、
C の LED でプリセット表示されます。

これらのプリセットは本体に保存されており、コンピ
ューターを接続する必要はありません。保存されたプ
リセットは、ステージへ持ち出してプレイすることも
できます。

Torpedoプロセッシングは、C.A.Bボタンを長押しし
てオフにすることもできます。

レコーディング

本機を用いてのレコーディング時には、2 つの入力信
号を同時に得ることができます。それらは Torpedo プ
ロセッシングを通ったものと、プロセスされていない
ドライ信号です。

ドライ信号とウェット信号を一緒に録音しておけば、
ミックス時にそれらをブレンドして興味深いトーンを
作ることができます。

また、ドライ信号を出力してアンプをマイク録音する
リアンプも可能です。もちろん、本機の CAB エミュレ
ーションは優れていますが、実際にアンプを録音した
サウンドも良いです。

リアンプのやり方は該当ページをご覧ください。
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ハードウェアハードウェア

ヘッドフォン出力

セミディスクリート＆クラス AB のヘッドフォーンア
ンプを装備しています。一般的な 8 〜 600 Ωのインピ
ーダンスのヘッドフォンが使用できます。また、この
出力は、小型アクティブモニタースピーカーへの出力
としても使用して頂けます。

To-amp出力

To-amp 出力は、DAW からのオーディオ出力信号を再
度アンプやペダルボードへ送り、「リアンプ」すること
ができます。

この「リアンプ」出力信号は、楽器レベルに下げられ
ているため、アンプやペダルをオーバーロードするこ
とはありません。

「リアンプ」出力へ信号を送るのは、DAW の出力 3
（Output 3）オーディーオアウトがリアンプアウト
（Re-amp output）へ接続されることです。

「リアンプ」出力ジャックにケーブルがつながれると、
本機内で自動的に信号ルーティングが切り替わります。

アプリ内のルーティングは無視され、モニターミック
スコントロールで調整されるように戻ります。

モニター＆ヘッドフォンコントロール

下図のように Sono のモニタリングコントロールは、
出力、ヘッドフォン、モニターミックスが独立してい
ます。
ヘッドフォンとボリュームは、デジタルコントロール
のアッテネータータイプです。全ボリュームレンジで
パーフェクトなステレオイメージを再生してくれます。

モニターミックス	コントロール

モニターミックス コントロールは、入力のみ〜コンピ
ューターのプレイバックのみまで、自在にモニターレ
ンジを移動＆再生をコントロールできます。

このモニターミックス コントロールは、Sono ミキサ
ーアプリが開かれ、ミキサーの設定をコントロールし
ている場合は動作しません。

オプティカル入力

オプティカル入力は、スタンダードな TOSlink コネク
ターを使用しており ADAT と S/PDIF の両入力に対応
します。

オプティカル入力は、Sono が外部クロックを必要な場
合にクロック信号も受けます。

モニター出力

リアパネルの出力は、アクティブモニターまたはパッ
シブモニター用のパワーアンプに接続するようにデザ
インされています。

これらの出力はバランス出力です。
モニタースピーカーへはバランスケーブルをお使いく
ださい。

これらの出力はラインレベルですから、コプレッサー
や EQ に接続できます。このように外部機器へ接続す
ると、モニタースピーカーへの出力がなくなります。



22 23

シグナルフロウ・ダイヤグラム

Inputs 1+2

Speakers

Headphones

To-Amp

Digital Inputs

DAW Playback 
1+2

DAW Playback 
3

シグナルフロウ・ダイヤグラム
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Input 
Sensing 

Switching
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Sono出力シグナルフロウ・ダイヤグラム

出力は本体のMonitor Mix、またはSonoミキサー（ソフト
ウェア）の2つの方法でコントロールできます。

下図は、両モードのオペレーション図です。

Monitor	Mixを使用したモニターコントロール

To-Amp出力にジャックが接続されると自動的にDAC出
力3の信号がTo-Amp出力にルーティングされます。 ヘッ
ドフォン出力には、DAC 1+2の出力がルーティングされ
ます。

Sono入力シグナルフロウ・ダイヤグラム

下図は、Sonoの入力信号シグナルフロウです。

入力は、Guitar inputにジャックが接続されると自動的に
背面のMic1がカットされます。To Valve設定にかかわら
ずも自動的にオンになります。

C.A.B ボタンが点灯＝Torpedoプロセッシングが行われ
ている状態です。
Torpedoプロセッシングは、C.A.Bボタンを長押しす
るとオフになります。

DAC
1+2

DAC
3

Volume

Volume

Input EQ Output

ADC

ADC

Torpedo Cabinet 
Processing 
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ソフトウェア

To- Amp 

Inputs 1, 2 
& No Cab

Digital 
Inputs

DAW Playback 
1+2

DAW Playback 
3+4

Cue MixMain Mix

DSP Mixer

Fader 
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Fader 
& Pan
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Routing 
Matrix

DAC
1+2

DAC
3+4
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ソフトウェアソフトウェア

Sonoミキサーを使用する

Sono ミキサーを起動すると、システムトレイに配置さ
れます。
Mac OS では、Sono アイコンが画面右上のメニュー
バーに表示されます。

Windows では、画面右下のシステムトレイ内に現れま
す。アイコンが見えない場合は、小さな矢印をクリッ
クして、システムトレイ内すべてのアイコンを表示し
てください。

右クリック→「Show Mixer」でミキサー画面が表示さ
れます。
それを起動すると、ソフトウェアの使用中には、ハー
ドウェアの Monitor Mix コントロールはソフトウェア
で制御され、使用できない警告が表示されます。

Sono ミキサーは拡張機能を使用するためのオプション
です。CUE MIX やオプチカル入力のルーティングを行
います。

シンプルな操作でギターやマイクの音を録音したい場
合は、使用する必要はありません。本体の MONITOR 
MIX を使用すると、演奏する楽器とバックトラック（ク
リック…etc）のバランスが調整できます。

 
ここで行われた調整はモニターにのみ影響し、DAWに送
られる信号には影響しません。

ソフトウェア内で設定の変更を行うと、ハードウェアの各
種ノブの設定よりも優先されます。

ソフトウェア
Sono は 2 つのソフトウェアでコントロールされます。
このセクションでは、それぞれのソフトウェアに関し
て説明していきます。

Sono Application

28ページ〜

「Sono ミキサー」ソフトウェアの使用を使用すれば、
Cue ミックスやオプティカル入力などの拡張機能がコ
ントロールできます。

 

Two notes Torpedo Remote

39ページ〜

Two Notes の Torpedo Remote は、キャビネットや
マイクの選択、パワーアンプの設定などキャビネット・
シミュレーターの詳細が設定できます。
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Sono アプリケーションSono アプリケーション

システムトレイのメニュー

Sono の動作を補助する様々な機能へ、システムトレイ
からクイック・アクセスできます。

Show	Mixer
ミキサーのウィンドウを表示します。

Quit
Sono ミキサーのアプリケーションを終了します。

About	Sono
Sono ミキサーのバージョン情報を表示します。

Visit	Sono	Knoweldge	Base
ヘルプデスク（英語版）の Web ページに移動します。

Check	for	Updates
アップデート可能なファームウェアが無いかを確認し
ます。

Set	ASIO	Buffer	Size	(Windows	のみ )
DAW で使用しているバッファーサイズを変更し、レイ
テンシーを調整します。

Set	Sample	Rate
動作サンプルレートを設定します。

Software	Controlled	Mixer	Mode
ハードウェア上のノブと Sono ミキサーのソフトウェ
ア上、どちらから Monitor Mix を操作するのかを選択
します。

このモードがON（チェックが入っている状態）の場
合、Sono本体のノブは動作しません。

Analogue Input 
Channels

DAW Return 
Channels

Mix Selection Pane

Digital Input 
Channels

Monitor Controls

Channel View 
Options
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Sono	ミキサー・ソフトウェアSono アプリケーション

チャンネル・ストリップ機能

Channel	Name（チャンネル名）
コンソールにトラック名をテーピングする様に、各チ
ャンネルに名前を付けることができます。

Phase	Reverse（位相反転ボタン）
チャンネル信号の位相（左チャンネル）を反転させます。
この機能はファンクション・スイッチに割り当てる事
ができます。

Pan	Contro（l	パンのコントロール）
メイン・ミックスや Cue に送られる信号のパン（左右
の定位バランス）を調整します。

Stereo	Link（ステレオ・リンク	/	グループ設定）
全てのチャンネルはステレオ・リンクが可能です。レ
ベルのコントロールは 1 つになりますが、PAN は両チ
ャンネルとも定位の設定が可能です。

Solo（ソロ）とMute（ミュート）
Solo： 選択されたチャンネル以外が全てミュートされ

ます。複数を同時に SOLO 設定可能。
Mute： 選択されたチャンネルがミュートされます。

Meter（メーター）
信号レベルを dBFS 表示します。

Fader（フェーダー）
信号の量を調整します。
範囲：- ∞ 〜 +10dB

Sonoミキサーのチャンネル・ストリップ
Sono ミキサー上にある複数のチャンネル・ストリップ
で、各入力や DAW からの信号のモニターバランスを
調整します。

Mic	1/DI
本体背面にある Mic/Line 1 からの入力信号、または本
体前面のギターの入力信号です。
ギター入力にジャックが接続されると、Mic/Line 入力
はカットされます。

Mic	2
本体背面にある Mic/Line 2 入力からの信号です。

No	C.A.B
このチャンネルは Mic/Line 1 入力／ギター入力からの
同信号です。Two Notes Torpedo のプロセッシングを
通っていない信号です。リアンプ用に使用する未処理
信号として使用する便利なトラックです。

Digi	1-8
オプティカル端子からの音声です。ADAT の場合 8ch、
S/PDIF の場合 2ch を最大で拡張できます。

DAW	1+2
DAW ソフトウェアの出力 1 〜 2 や、音声アプリケー
ションからのプレイバック信号です。

DAW	3+4
DAW ソフトウェアの出力 3 〜 4 のプレイバック信号
です。複雑なモニターミックスを使用する場合に便利
な出力です。DAW3 はリアンプ出力としても使用され
ます。

Channel 
Name

Phase 
Reverse

Stereo Link

Pan

Channel 
Meter

Solo & Mute

Channel 
Fader
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Sono	システムパネルSono	ミキサー・ソフトウェア

Sono Mixer Application

システムパネル
システムパネルでは、拡張機能やデバイスの動作設定
を行います。

View > Show System Panel でシステムパネルを開き
ます。

System Panel Overview:

マスターセクション機能
グローバルな設定を行うのがマスターセクションです。

Master	Mix（マスターミックス）
Master Mix 選択時には、全てのフェーダーのパラメー
ター変化がこの Master Mix に影響します。

Cue（Cueミックス）
2 つめのモニターミックスとして使用できるミックス
です。この設定を選択すると、各フェーダーは Cue に
送られる音量バランスに変更されます。選択時、ミキ
サーの色はグリーンに変化します。

Cue	Solo（CueミックスのSOLO）
メイン出力で Cue ミックスを聴く時に使用します。素
早く Cue ミックスに切り替えられるため、それぞれの
ミックスをチェックする時に便利な機能です。

Channel	View（チャンネル表示ボタン）
ミキサー上のレイアウト・カスタマイズが可能です。
使用例： デジタル入出力を使用していない場合：　
OPTICAL をオフにすると「デジタル入力」がミキサ
ー上から消えます。

Monitor	Controls（モニターコントロール）
モニターに関するファンクションをコントロールしま
す。

TB	( トークバック )
トークバックのオン／オフを行います。
トークバックの設定は「システムパネル」で行います。

	ø	( 位相反転 )
モノラルにサミングし、片チャンネルの位相（左チャ
ンネル）を反転させます。これによりステレオ時の真
ん中に定位された音がキャンセルされます。

Mono（モノラル）
ステレオ信号を、モノラル信号にサミングします。

スピーカー／ヘッドフォンのミュート
各アイコンをクリックすると、モニターまたはヘッド
フォンの出力がミュートされます。
ミュートされた出力には「×」が表示されます。

 

Optical 
Format Talkback 

Setup

Routing 
Matrix

Preferred 
Clock Source

Mono Mode

Dim Trim

Master 
Mix

Monitor 
Controls

Channel 
View

Cue 

Cue 
 Solo
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Sono	システムパネルSono	システムパネル

トークバック設定
Sono は、プレイヤーとエンジニアの間でコミュニケー
ションを取るためのトークバック機能を備えています。
全ての入力だけでなく、コンピューターの内蔵マイク
や外部 USB マイクもトークバック用のマイクとして使
用できます。

使用するソース（マイク）は、システムパネルの
「Talkback」で設定します。

 

Source（トックバックのソース）

Internal：
Sono ミキサー上で選択できるソースから選択します。

External：
コンピューターに接続された外部機器（内蔵マイクや
USB マイク等）を、トークバック用に使用できます。

External Source Audio Settings（外部マイクの設定）
コンピューターの内蔵マイクや外部 USB マイクを使用
する場合、そのソースを選択します。

Optical	Format
（デジタル入力のフォーマット）
デジタル入力（オプティカル）のフォーマットを
ADAT or S/PDIF から設定します。

Preferred	Clock	Source（クロックソース）
クロックソースを「内部クロック（INTERNAL）」と

「外部のクロック（DIG1）」から選択します。デジタル
入力（オプティカル）のクロックを使用する場合には
DIG1 を選択します。
インジケーターが外部クロックと正常にロック（同期）
を表示します。

Red ：問題が発生しています。接続や設定を確認して
ください。

Amber ：クロック信号は入力されていますが、サンプルレ
ートが合っていません。

Green ：正常な接続が確立しています。

Mono	Mode（Monoモード）
Mono Sum をオンにした時のスピーカーの定位を設定
します。デフォルトはセンターです。

Dim	Trim（DIM	のレベル）
DIM 時のレベルを設定します。

Routing	Matrix（ルーティング設定）
Sono の各出力（スピーカー／ヘッドフォン）に、以下
のどのソースをルーティングするのかを設定します。

Main	Mix：
Master Mix（マスターミックス）。最もスタンダード
なプレイバック・ソースです。

Cue	Mix：
Main Mix と同様に Master Mix（マスターミックス）
をソースとしますが、特定の Cue が選択された時のみ
ルーティングされます。サブミックスを作成した時に
便利です。

DAW	THRU：
オーディオ・ドライバーから信号を直接ルーティング
されるため、Sono ミキサー上の全てのコントロールを
スルーします。アウトボードやモニターコントローラ
ーなどフル・ラインレベルの出力が要求される時に便
利なソースです。
ボリュームのコントロールを通らないので、大音量が
出力される場合があります。ご注意ください。
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Sono アプリケーションSono アプリケーション

キーボードのショートカット一覧
キーボードのショートカットを使用して Sono ミキサー
をコントロールできます。

Location  Mac   Windows  Description
  
Faders  Alt + Click  Alt + Click  フェーダーをユニティーゲイン（0dB）に設定する。 

Pans   Alt + Click  Alt + Click  パンの設定をセンターに戻す。 

Solos   Cmd + Click                Ctrl + Click  Solo設定された全てのチャンネルを解除する。

Solo設定されていないチャンネル上でこの操作
を行うと、既に設定されているSoloが全て解除
された上で新たにSoloが設定されます。

Meters  Alt + Click  Alt + Click  全てのクリップ表示をリセットします。 

Mixer Screen  Cmd + S  Ctrl + S  「iDミキサー」の状態をセーブします。
   Cmd + O  Ctrl + O  「iDミキサー」の状態をロードします。 

View Modes                Cmd + 1  Ctrl + 1  Mic/Line入力トラックの表示。
   Cmd + 2  Ctrl + 2  Optical（デジタル）入力トラックの表示。
   Cmd + 3  Ctrl + 3  DAW MIX入力トラックの表示。 
   Cmd + 4  Ctrl + 4  システムパネルの表示。

ファームウェアのアップデート

Audient では、機能の追加やバグ修正のために、ファ
ームウェアのアップデートを行う場合があります。定
期的にファームウェアの更新状況をチェックすること
をお勧めします。

メニューの Check for Updates にチェックを入れる
と、自動的にファームウェアのアップデート更新情報
を確認し、アップデート確認の画面が表示されます。
アップデートの画面で「NEXT」をクリックするとアッ
プデートが続行されます。アップデート中に、何度か
Sono が再起動することがあります。アップデートが終
了したら、Sono の電源をオフにし、数秒経ってから再
び電源をオンにしてください。

プリセットのセーブする。

ミキサーの設定を、プリセットとしてセーブ＆ロード
する事ができます。

プリセットの保存
「File > Save」をクリックすると、プリセットのセーブ
画面が表示されます。プリセットに名前を付けて保存
してください。

セーブ画面で「Export Mixer Configuration」を選択
すると、任意のフォルダーに保存ができます。名前を
付けて、確認しやすいロケーションに保存してくださ
い。

プリセットの呼び出し
「File > OPEN」をクリックすると、プリセットのロー
ド画面がリスト表示されます。ロードしたいプリセッ
トを選択してください。
ロード画面で「Load From File」を選択すると、任意
のフォルダーに保存されたファイルから直接プリセッ
トをロードできます。
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Torpedo Remote アプリケーション

Two notes 
Remote ソフトウエア

Torpedoリモート・アプリケーション
Sono は Torpedo キャビネット・シミュレーションの
機能を備えています（本体内の DSP でプロセッシング
されます。）。デスクトップからの操作で、リアルでパ
ンチのあるギター・サウンドへ簡単にアクセスできま
す。このアプリなら、キャビネット、マイク、ルーム
など様々なパラメーターが設定できます。

Torpedo	Remote	アプリケーション:

レベルのメーター
出力ボリューム マイク選択

パワーアンプ
設定

キャビネット選択

ルーム選択プリセット選択

キャビネット検索

トーン設定

マイクの
設置距離

コンツァー
（キャラクター）

設定 プリセットのレベル
Level Meters

Output Volume

Microphone 
Selection

Power Amp 
Setting

Cabinet 
Selection

Room 
Selection

Preset 
Selection

Cabinet 
Search

Tone 
Settings

Microphone 
Distance

Contour 
Control

Preset Level
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Torpedo Remote アプリケーションTorpedo Remote アプリケーション

初期設定

最初にTorpedo Remote ソフトウェアを起動すると、ログ
イン画面が表示されます。

既にTwo Notes アカウントをお持ちの場合は、ログインし
てください。

（要インターネット接続）

アカウントをお持ちでない場合には、サイン・インをクリッ
クしてアカウント登録してください。

サイン・インが完了すると、Sonoのアイコンがデバイスのド
ックに表示されます。表示されない場合には、Sonoの電源
やUSB接続を確認してみてください。

Sonoのアイコンをクリックしてアプリケーションを起動し
ます。この時点でアカウントにSonoを製品登録する必要が
あります。 

Registerをクリックして、画面の手順に従い製品登録を行
ってください。製品が登録されると、20種類のキャビネット
が使用可能になります。 
キャビネットのダウンロードには、数分かかる場合がござ
います。

これで準備は完了です。

キャビネットを選択する
キャビネットには、様々な形やサイズ、スピーカーの
種類や数などの違いがあります。その組み合わせによ
ってサウンドは大きく変化するため、十分なトライア
ルが必要です。

CABINET（キャビネット）選択メニュー、またはキャ
ビネットの画像の左右にある矢印で切り替えて試すこ
とができます。

コンピューターのマークはダウンロード済み、Sono の
マークは Sono 本体に転送済み、クラウドマークは未
購入品です。

スピーカーは、サイズやスピーカーの数によってカテ
ゴリー分けされています。
ギター用だけでなく、低域に特化したベース用キャビ
ネットも用意されています。

デフォルト状態でも数多くのキャビネットが収録さ
れていますが、さらに追加したい場合は Two Notes 
Store から追加購入ができます。

https://store.two-notes.com/en/

※ 未購入キャビネットはプレビューできますが、
数秒ごとに音切れが断続的に発生します。
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Torpedo Remote アプリケーション Torpedo Remote アプリケーション

ルームを選択する
キャビネットとマイクを設定したら、次は環境異なる
部屋を選択します。
画面の上部にある左右にある矢印でルームを切り替え
ます。

ルーム一覧

Studio	A（スタジオA）
多少の吸音効果があり、短くルーズなリバーブが残っ
た小サイズのライブルーム。

Studio	B（スタジオB）
壁の反射が多く、Studio A と比べて長めのリバーブを
発生する中サイズのライブルーム。

Basement（地下室）
反射が多い石壁の部屋。

Loft（ロフト）
アーリーリフレクションと適度な減衰がある中サイズ
の部屋。

Hall	A（ホールA）
適度な長さのリバーブタイムがある小さめのライブホ
ール。

Hall	B（ホールB）
座席やカーテンによる減衰がある、長めのリバーブが
ある大きめのホール。

Crypt（地下道）
凹凸ある石壁による反射と、多いアーリーリフレクシ
ョン、長いリバーブ時間が特徴の空間。

Cathedral（聖堂）
長いプリディレイ、多いアーリーリフレクション、長
いリバーブ時間が特徴の広い空間。

マイクを選択する
キャビネットのサウンドを録音するには、マイクロフ
ォンが必要です。この Two Notes アプリケーションで
は、バーチャル録音用の様々なマイクロフォンを用意
しています。

温かでルーズなサウンドのリボンマイクから、パンチ
感のあるダイナミックマイク、そして繊細なサウンド
まで捉えるコンデンサーマイクまで幅広く選択できま
す。

画面上でマイク画像の左右にある矢印でマイクを切り
替えます。

また、マイクとキャビネットの距離も調整可能です。
距離を近付けると輪郭のハッキリしたダイレクトなサ
ウンドが得られ、遠ざけるとルーム感のあるサウンド
が得られます。
この距離設定はアプリケーション内のラックにある
DISTANCE を使用して行います。

CLOSE（近い）／FAR（遠い）



44 45
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プリセットを保存する
設定が完了したら Sono 本体の C.A.B に保存しましょ
う。Sono 本体に保存したプリセットは、C.A.B スイッ
チで切り替えて呼び出せます。C.A.B に保存された 3
つのプリセットは、Sono のオンボード DSP でプロセ
ッシングさますから、Sono 本体だけでもプレイできま
す。

保存はラック内 PRESET の右上にある SAVE をクリッ
クします。

本体に保存する際は、保存スロットを選択します。

注意： 上書き保存されると、前の内容はリコールでき
ません。

4つ目以降のプリセットは、コンピューターに保存すること
ができます。
Save PresetsタブのComuputeを選択してください。

プリセットの内容は、Torpedo Remoteアプリケーション
内のプリセット・マネージャーで確認できます。

コンピューターに保存されたプリセットを、ドラッグ＆ドロ
ップで本体に移動することができます。

同様に、Sono本体の設定をラッグ＆ドロップで消去する事
も可能です。

トーンの設定
最後に、エフェクトラック内のパラメーターでトーン
を調整します。

Power	Amp（パワーアンプ）
パワーアンプのサチュレーション（歪み）の深さを調
整します。高い数値に設定するにしたがって、チュー
ブアンプの音量を上げた時のパワーアンプ歪みが得ら
れます。
このコントロールは Sono 本体の Drive と連動してお
り、Sono 本体で操作するとこの画面上の操作はロック
されます。

Contour（コンツァー）
サウンドのキャラクターを設定します。
コントロールを VINTAGE に近づけると中域が強調さ
れ、MODERN に近づけると中域がスクープされた（低
域と高域が強調された）サウンドになります。

Tone（トーン）
トーンを調整します。
コントロールを DARK に近づけると低域が強調された
サウンドになり、BRIGHT に近づけると高域が強調さ
れます。

Preset/Output	Level（プリセット／出力レベル）
プリセットと出力、それぞれのレベルを設定します。
各プリセットはそれぞれの設定により若干の音量差が
出る為、この PRESET LEVEL でプリセット間の音量
を調整します。
OUTPUT LEVEL は、最終的な出力音量のレベルを調
整します。プレイバックの音が大きいと感じた時は下
げてください。
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Torpedo Remote アプリケーション

Cabinet	Manager
（キャビネット・マネージャー）
キャビネット・マネージャーでは、使用可能なキャビネット
のリストや、現在Sono本体で使用されているキャビネット
の種類が確認できます。
Torpedo Remote のトップ画面からキャビネット・マネー
ジャーにアクセスできます。

Cabinet ManagerでSono本体に転送されたキャビネッ
トは、キャビネット選択時に素早くロードできます。

一覧リストからキャビネットをドラッグ＆ドロップでSono
本体に保存できます。本体スロットがいっぱいの時には、
どれか1つ消去しないと新たなキャビネットは移動できま
せん。

注意：
キャビネットを使用するためには、キャビネット・マネージ
ャーを使用して3つの本体スロットの内1つに保存されて
いないと使用できません。
入れ替えずスロットを選択すると、既存のキャビネットが
そのまま使用されます。

デフォルトで使用可能なキャビネット デフォルトで使用可能なマイク

リストに登場する製品名及び会社名は、各社の商号、登録商標または商標です。
また、商品名はサウンドのキャラクターを表すために使用されており、実際の機器とは関係がありません。 
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DAW セットアップ

Pro Tools Setup

Pro	Tools	と使用する場合
インストールが完了したら、Pro Tools を起動して新
たなセッションをスタートします。その際は、必ずサ
ンプルレートの設定を確認してください。外部クロッ
クを使用する場合は、両方のサンプルレートを同一値
に設定してください。

Windows 版の使用時は、特に Sono アイコンよりレイ
テンシーとバッファーサイズの設定に注意してくださ
い。これはプロジェクトを開く前に必ず行いましょう。
その設定が ProTools 起動時に反映されます。

プレイバックエンジン
Setup > Playback Engine でプレイバックエンジンの
設定へ進みます。

I/O	セットアップ
セットアップ から I/O へ進みます。
上記設定画面で、入力と出力の設定を行います。Sono
の 11 入力／ 4 出力がルーティングを確認してくださ
い。

Sono ミキサーのソフトウェア内で、Pro Tools の出力
信号が 1 度バーチャル・チャンネルとして DSP ミキ
サーを経由するか、または直接 DA コンバーターに送
られるかが設定できます。

設定に関する詳細は、Avid の取扱説明書をご参照くだ
さい。
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Logic Pro Setup Logic Pro Setup

I/O の設定
Sono の入出力（11 入力／ 4 出力）は、全て Logic の
入出力先として表示されます。

入出力の名前が I/O ラベルの画面で変更でき、信号ソー
スの整理が簡単です。

Mix ＞ I/O ラベル

Logic	Pro	を使用する場合
インストールが完了したら、下記の設定画面を開いてく
ださい。

Logic Pro > Preferences > Audio

まず、プレイバック用デバイスに Sono の設定（選択）
を確認してください。バッファーサイズの設定もこの画
面で行います。「CPU オーバーロード」警告、ノイズ、
サウンドの歪みなどが発生した場合は、バッファーサイ
ズを大きく変更してください。

「Sono ミキサー」で入力信号をモニターしている場合は、
Logic のモニタープレイバックを切ってください。DSP
とソフトウェア間で起こる信号の遅れにより、音が二重
に聴こえてしまいます。

他の設定に関しては、Logic Pro の取扱説明書をご参照
ください。

外部デジタル機器（ADAT/SPDIF より）から Sono の
クロック・ソースを得る場合は、レコーディングもプレ
イバックも、Logic Pro と Sono のサンプルレートを同
一に設定してください。

ファイル＞プロジェクト設定＞オーディオ＞サンプルレ
ート

Sono の内部クロック（INTERNAL）をマスターにする
場合、Sono のクロック値は Logic Pro のサンプルレー
ト設定に追従します。クロック変更後、同期するために
短いポーズが発生しますが、これは正常です。この設定
は下記の画面で行えます。
アプリケーション＞ユーティリティ＞ Audio MIDI 設定
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Cubase Setup Cubase Setup

Sono をデバイスとして選択します。「切り替えますか？」
と質問メッセージが出たら、「はい」をクリックして切り
替えます。

デバイスメニューで Sono を選択します。バスはモノラ
ル／ステレオどちらでも設定でます。VST コントロール・
ルームの操作も可能です。ADAT や SPDIF など、デジ
タル入力をクロック・ソースとする場合は、外部クロッ
クに設定してください。

Cubase	と使用する場合
インストールが完了したら、下記の設定画面を開いてく
ださい。
デバイス＞デバイス設定

デバイスメニューで、VDT Audio System を選択します。

Cubase / Nuendo で設定したバスの管理もこの画面で
行います。
バスはモノラル／ステレオどちらでも設定でき、VST コ
ントロール・ルームも使用できます。

他の設定に関しては、Steinberg の取扱説明書をご参照
ください。

バッファーサイズの設定は、VST デバイスの画面で行い
ます。Sono の DSP ミキサーを入力用のモニタリングに
使用すると、コンピューターの CPU の負荷を抑えるこ
とができます。I/O ポートの名称は変更できます。

I/O ポートの名前は変更できます。「メインモニター」
「ALT モニター」など分かりやすい名前に変更すると便
利でしょう。ここで変更された名称は、DAW トラック
の画面上にも反映されます。

VST コネクションの画面から、Cubase/Nuendo 上で作
成されたバスの確認や追加、それらがルーティング可能
か否かの確認ができます。
デバイス > VST コネクション（F4）
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Support & ARC スペシフィケーション

Audient	ARC	-	無料ソフトウェア

DAW & プラグインソフトをプレゼント。
Audient サイトに登録するだけで、DAW ＆プラグイン
ソフトがもらえます。

日本語解説ページは、こちら：
http://allaccess.co.jp/audient/campaign/arc/

マイク・プリアンプ
MIC GAIN: 0 to +60 dB
LINE GAIN: -10 to +50 dB
ファンタム電源 : 48v +/-4v @ 10mA/Channel
MIC EIN（等価入力雑音）: -128dBu
CMRR（同相信号除去比）: >80dB @ 1kHz
最大入力レベル : +16dBu
入力インピーダンス (Mic): >3k Ω Balanced
入力インピーダンス (Line): >10k Ω Balanced
周波数特性 :: +/-0.5dB 10Hz to 22kHz
クロストーク : <-90dB @ 1kHz & 10kHz
THD+N @ 0dBu (1kHz): 0.003% (-96dBu)
SNR: 96dB A-Weighted
XLR: Pin 2 (Hot), Pin 3 (Cold) & Pin 1 (Shield)
1/4” JACK: TIP (Hot), RING (Cold) & SLEEVE (Shield)

D.I:
D.I MAX GAIN: 20 dB
最大入力レベル : ( ユニティーゲイン ): +4dBu
入力インピーダンス :: 1Meg Ω Unbalanced
周波数特性 : ± 3dB - 10Hz to 22kHz
THD+N @ 0dBu (1kHz): 1.50%
SNR: 90dB
1/4” ジャック : TIP (Hot) & SLEEVE (Shield)

ADC	入力 :
最大入力レベル : 16dBu
デジタル・リファレンスレベル :: 0dBFS = +16dBu
周波数特性 : +/-0.5dB 10Hz to Fs/2
クロストーク : <-115dB @ 1kHz & 10kHz
THD+N @ -1dBFS (1kHz): <0.0015%
ダイナミックレンジ : 115dB A-weighted

スピーカー出力 :
最大出力レベル : +16dBu
デジタル・リファレンスレベル : 0dBFS = +16dBu
出力インピーダンス : <100 Ω Balanced
周波数特性 : +/-0.5dB 10Hz to Fs/2
クロストーク : <-120dB @ 1kHz & 10kHz
THD+N @ -1dBFS (1kHz): <0.0015%
ダイナミックレンジ : 114dB A-weighted
1/4” ジャック : TIP (Hot), RING (Cold) & SLEEVE (Shield)

電源
12VDC ／センタープラス／ 2A
+48VDC 供給、+/-12VDC 動作用に内部昇圧
• USB によるバスパワーでの動作不可

寸法と重量
本体重量 : 1.25kg
パッケージ総重量 : 2.0kg
本体寸法 : 229mm (w) x 67mm (h) x 165mm (d)
パッケージ寸法 : 315mm (w) x 112mm (h) x 226mm (d)

ヘッドフォン出力 :
最大出力レベル : +16dBu
デジタル・リファレンスレベル : 0dBFS = +16dBu
出力インピーダンス : <50 Ω Balanced
周波数特性 : +/-0.5dB 10Hz to Fs/2
クロストーク : -90dB @ 1kHz & 10kHz
THD+N @ -1dBFS (1kHz): <0.002%
ダイナミックレンジ : 114dB A-weighted
出力レベル 30ohms: +10dBu, 0.0015% THD+N, 3.7Vpk Power:
456mW or Pavg 228mW
最大出力レベル 60ohms: +13.5dBu, 0.0015% THD+N, 5.17Vpk
Power: 445mW or Pavg 222mW
最 大 入 力 レ ベ ル 600ohms: +15.8dBu, 0.0015% THD+N, 
6.77Vpk
Power: 76mW or Pavg 38mW
1/4” ジャック : TIP (Hot), RING (Cold) & SLEEVE (Shield)

TO-AMP	出力 :
最大出力レベル : -12dBu
デジタル・リファレンスレベル : 0dBFS = -12dBu
出力インピーダンス : <50 Ω Balanced
周波数特性 : +/-0.5dB 10Hz to Fs/2
THD+N @ -1dBFS (1kHz): <0.002%
ダイナミックレンジ : 95dB A-weighted
1/4” ジャック : TIP (Hot) and SLEEVE (Shield)

デジタル (TOSLINK) 入力 :
ADAT 8 CHANNELS 44.1 - 48kHz
ADAT 4 CHANNELS (SMUX) 88.2 - 96kHZ
STEREO S/PDIF 44.1 - 96kHz

USB 2.0 HIGH SPEED
入力チャンネル数 : 10 (2 Analogue, 8 Digital)
出力チャンネル数 : 4 (4 Analogue)
コネクター : USB Type-C
付属ケーブル : 1.5m USB 2.0 Type-C to USB Type-C
1.5m USB 2.0 Type-C to USB Type-A

Sono	DSP	ミキサーのレイテンシー :

Torpedo プロセッシングなし
44.1 kHz 0.677ms
48.0 kHz 0.625ms
88.2 kHz 0.354ms
96.0 kHz 0.3236ms

Torpedo プロセッシングあり
44.1 kHz 4.63ms
48.0 kHz 4.18ms
88.2 kHz 3.26ms
96.0 kHz 2.99ms
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品質保証

A  Amperes
ADAT  Alesis Digital Audio Tape
ADC  Analogue to Digital Converter
DAW  Digital Audio Workstation
CPU  Central Processing Unit
CUE  Artist Headphone Mix
DAC  Digital to Analogue Converter
dB  Decibel
dBu  Decibel referenced to 0.775Vrms = 0 dBu
dBFS  Decibel Full Scale
DC  Direct Current
D.I  Direct Injection (Instrument Input)
DoC  Declaration of Conformity
DSP  Digital Signal Processing
EQ  Equaliser
FAQ  Frequently Asked Questions
FCC  Federal Communications Commission
GB  Gigabyte
GUI  Graphical User Interface
HPF  High Pass Filter
HV  High Voltage
I/O  Input / Output
LED  Light Emitting Diode
RoHS  Restriction of Hazardous Substances
RAM  Random Access Memory
S/PDIF Sony Philips Digital Interface Format
THD+N Total Harmonic Distortion + Noise
TRS  Tip Ring Sleeve (1/4” Jack Balanced)
TS  Tip Sleeve (1/4” Jack Unbalanced)
USB  Universal Serial Bus
V  Volts
XLR  Extra Live Return, Extremely Low Resistance, 
  Canon X Series, Latching, Resilient Rubber Compound... or make up your    
  own!

用語

Mail audient@allaccess.co.jp

WEB www.allaccess.co.jp

お問い合わせはこちら

本  社
名古屋オフィス

東 京 都 渋 谷 区 桜 丘 町 30 - 4 - 404
愛 知 県 あ ま 市 四 反 田 27 番 地

■品質保証に関して
本機は、audient 日本総代理店　オールアクセスインターナショナル株式会社がご購入後１年以内の品質保証を行っております。修理の際は、
購入時の保証書（購入期日及び販売店捺印必須）を提示の上、ご購入の販売店に御依頼下さい。保証書の提示が無い場合、保証内であっても
１年以内の保証の対象にはなりません。また、全ての商品には、シリアルナンバーが登録されています。

本書に記載された文章、図版、作品は、全て「著作権」及びそれに付随する「著作隣接権」等の諸権利を保有しています。弊社では、内容を
理解することを目的とする使用方法のみを許諾しております。

▲警告：安全のため、特に注意していただきたいこと
1. 異常があるときは、電源プラグをコンセントから抜いてご購入先もしくは、弊社迄ご連絡下さい。異常な音がしたり煙が出て異臭がした
時などは、電源プラグをコンセントから抜いて下さい。
2. 電気ショックを避けるため、本体を絶対に開けないで下さい。
本機は、高電圧が発生しているため危険です。内部に触ると感電する恐れがあります。内部の調整や修理は、弊社にご依頼下さい。また、
火事や感電を避けるために、湿度が非常に高い場所に置いたり、雨天の際に野外で使用することは避けて下さい。

▲警告：次のような場所での使用は出来る限り避けて下さい。  
●湿度の非常に高い場所
●砂やほこりが多い場所
●台所、バスルーム、湿気の多い地下室など、水のかかりやすい場所
●空気の循環を妨げる場所、ヒーターの近くなど、温度が高い場所

■取り扱いについて
乾いた柔らかい布を使用して、外装をきれいに保ちましょう。
クリーナーやシンナーは使用しないで下さい。

■サービスについて
このマニュアルに記載されていない操作や取り扱いは行わないで下さい。記載外の使用方法で本機を使用されますと製品不良が発
生する場合が考えられます。必ず本書に基づいた使用方法で使用して下さい。

記載外の使用方法による破損や修理は、保証期間中の機器であっても保証対象外になります。本体の取り扱いは慎重に行って下さ
い。万が一、負傷された場合でも弊社では一切の責任を負いません。

修理が必要な場合は、ご購入先もしくは、弊社へご依頼下さい。
Web：www.allaccess.co.jp　     Mail：audient@allaccess.co.jp
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